Importing *IntelliPics* Activities

**Tutorial**

*Note:* This tutorial requires that you have installed *IntelliPics Studio*. Authoring features necessary to complete this tutorial are not available when using *IntelliPics Studio Player*.

Copyright 2002, IntelliTools, Inc.
Copyright Notice

© 2002 IntelliTools, Inc. All rights reserved. The distribution and sale of this software and manual are authorized for the original purchaser only. Unauthorized duplication is a violation of federal copyright law.

Images that appear in IntelliPics Studio may not be used in any commercial application without the prior consent of IntelliTools, Inc.

Trademark and Acknowledgments

IntelliTools, IntelliPics, IntelliKeys, IntelliTalk II, and Overlay Maker, and their respective logos are registered trademarks of IntelliTools, Inc. IntelliMathics, IntelliCritters, IntelliMation, IntelliQuiz, Overlay Printer, and Overlay Sender are trademarks of IntelliTools, Inc.

Adobe and Acrobat Reader are registered trademarks or trademarks of Adobe Systems Incorporated, registered in the United States and/or other countries. Macintosh, QuickTime, and QuickTime logo are registered trademarks or trademarks of Apple Computer, Inc., registered in the U.S.A. and other countries. Windows 95, Windows 98, Windows 2000, and Windows ME are registered trademarks or trademarks of Microsoft Corporation, registered in the U.S.A. and other countries. Other brand and product names mentioned herein are trademarks, registered trademarks, or trade names of their respective holders and are hereby acknowledged.

Some photographic images included with this program are from the CD-ROM, “Picture This... Professional Edition” and are the copyright of Silver Lining Multimedia, Inc. If you would like to obtain more images that can be imported into IntelliTools products, please visit the Silver Lining Multimedia Web site: http://www.silverliningmm.com.

Over 90 of the images supplied with IntelliPics Studio are Picture Communication Symbols from the Boardmaker software, ©1981–2001 Mayer-Johnson, Inc. and are used with permission. Boardmaker has 3,000+ additional images that can be imported into IntelliTools products. For additional information about Boardmaker images, please visit the Mayer-Johnson Web site: http://www.mayer-johnson.com.

Credits


Technical Support

Hours: 8 a.m.– 5 p.m. Pacific Time, Monday through Friday
Phone: (800) 899-6687 (U.S. and Canada)
(707) 773-2000 (local and international)
Fax: (707) 773-2001
Email: tech@intellitools.com (for technical information)
info@intellitools.com (for general information)
World Wide Web: http://www.intellitools.com

Important note: To insure that returns are handled correctly and without delays, please call us for a Return Merchandise Authorization (RMA) before returning any item.
# Table of Contents

**Introduction** .......................................................................................................................................................................................... 2

Universal Design ........................................................................................................................................................................................ 2

About this Tutorial ..................................................................................................................................................................................... 2

**Part 1: Viewing Imported and Enhanced *IntelliPics* Activities**

Getting Started ......................................................................................................................................................................................... 3

  From the *Fun, Two, Three!* CD ...................................................................................................................................................... 3

  From *IntelliPics Studio* ..................................................................................................................................................................... 3

Viewing Ladybugs Song in Explore Mode ........................................................................................................................................ 4

Viewing Ladybugs Song in Design Mode ........................................................................................................................................ 4

Viewing Who is in the Shed? in Explore Mode .................................................................................................................................. 5

Viewing Who is in the Shed? in Design and Paint Modes .................................................................................................................. 5

Viewing Animated Animals in Explore Mode ..................................................................................................................................... 6

Viewing Animated Animals in Design Mode: .................................................................................................................................... 6

  Comparing Size ................................................................................................................................................................................. 6

  Using Color and Backgrounds ......................................................................................................................................................... 7

**Part 2: Importing *IntelliPics* Activities**

Importing *IntelliPics* Activities into *IntelliPics Studio's* Explore Mode ....................................................................................... 8

**Part 3: Importing into Explore, Paint, and Design Template**

Modifying the Snowman Activity for Explore Mode .......................................................................................................................... 10

**Part 4: Using the the Explore, Paint, and Design Template**

Modifying the Snowman Activity in Design Mode ............................................................................................................................. 10

  Modifying Page 1 ............................................................................................................................................................................. 12

  Modifying Page 2 ............................................................................................................................................................................. 13

  Modifying Remaining Pages ....................................................................................................................................................... 13

Adding Page Sound .................................................................................................................................................................................. 14

Adding Finishing Touches ...................................................................................................................................................................... 14

Saving as a Template ............................................................................................................................................................................. 15

**Part 5: Creating the Overlay**

Making the Overlay .................................................................................................................................................................................. 16

Modifying the Overlay ........................................................................................................................................................................... 16
IntelliPics® has been a very successful multimedia authoring tool for almost a decade. Created with universal design principles, it enables students, teachers, therapists, and parents to customize curriculum and create activities that are engaging, interactive, and accessible to all students. Many wonderful IntelliPics activities can be found on the IntelliTools Activity Exchange and in classrooms across the nation. These activities range from simple cause and effect to sequencing and electronic storybooks.

IntelliPics® Studio is IntelliTools’ new and improved multimedia authoring tool. This program contains the elements of IntelliPics, plus more! Activities created in IntelliPics can be used in the Explore mode of IntelliPics Studio. Two additional modes of IntelliPics Studio, Design and Paint, allow teachers to create activities that move beyond cause and effect and enable students to write, color, design, paint, and even create their own activities. Activities can be saved into student portfolios, and access can be provided at a variety of levels.

A new template, called Explore, Paint, and Design, has been added to IntelliPics Studio. This template can be used to import activities created in IntelliPics into IntelliPics Studio. It can also be used to create new activities.

Your time is valuable. When you use the new Explore, Paint, and Design template, you will see that an activity that engages a student in cause and effect using Explore mode can use the same palettes and curriculum content in Design and/or Paint mode. These added modes and program enhancements provide students with a greater degree of interaction, promoting their growing comprehension and independence.

This tutorial will show you how to import existing IntelliPics activities into IntelliPics Studio and to extend them beyond simple cause and effect activities. The tutorial will guide you through the sample activities on the IntelliPics Studio Fun, Two, Three! CD and inspire you to move ahead and enjoy the powerful new program IntelliPics Studio.

Universal Design

The activities you create using the Explore, Paint, and Design template and IntelliPics Studio are designed for all students, including those with physical or cognitive disabilities. These activities are ideal for inclusion classrooms, because all students can use them: with a mouse, an IntelliKeys® keyboard, or a switch. The activities referred to in this tutorial include custom overlays.

Important Note

This tutorial requires that you have installed IntelliPics Studio. Authoring features necessary to complete this tutorial are not available when using the IntelliPics Studio Player.

About This Tutorial

You will start this tutorial by looking at some of the most popular IntelliTools IntelliPics activities. These activities have been imported into IntelliPics Studio to demonstrate the benefits of using this versatile multimedia program with your students.

When an IntelliPics activity is imported into IntelliPics Studio, it can be imported in two ways:

1. Into an Explore template – this displays the activity as it originally appeared. In IntelliPics Studio, this view is called “Explore” mode.

2. Into an Explore, Paint, and Design Template – this displays the activity in a document that has many additional program features. In IntelliPics Studio, “Paint” and “Design” are the two modes a teacher uses to author or modify an activity. It is easy to switch between modes using menu options or by clicking a palette item.

The illustrations in this tutorial are intended to be similar to what you see on-screen. Some may differ depending on the computer system you are using.
Part 1: Viewing Imported and Enhanced IntelliPics Activities

Getting Started
You will start by opening a simple activity—Ladybugs Song. This IntelliPics activity has already been imported into the IntelliPics Studio Explore, Paint, and Design template. First, you will view Ladybugs Song in Explore mode. Next, you will view the same activity in Design mode.

To begin this activity, use one of the following procedures, depending on whether you are working directly from the IntelliPics Studio Fun, Two, Three! CD or working from files that have been installed on your computer’s hard drive.

From the Fun, Two, Three! CD
1. Open the Fun, Two, Three! CD.
2. Click the opening screen to proceed.
3. From the Home page that displays, click the Imported IntelliPics Activities 1 button.
4. Click the Ladybugs Song button. The Ladybugs Song activity displays.

Beginning from IntelliPics Studio
1. If it is not open, launch IntelliPics Studio. When the program launches, the Home page is displayed.
2. Click the Open My Documents button.
3. Click the Template tab. From the Subject Area drop-down menu, select Fun Two Three.
4. Select the Ladybugs Song template. Click Open. The Ladybugs Song displays.
**Part 1: Viewing Imported and Enhanced IntelliPics Activities**

**Viewing Ladybugs Song in Explore Mode**
1. After the title page reads aloud, click the first screen to hear the song and see the animated effects.
2. Click the screen again to proceed.

Because students only need to respond with a single click of a mouse, switch, or touch on an IntelliKeys keyboard, this is a simple cause and effect activity.

**Viewing Ladybugs Song in Design Mode**

Next, you will view this popular activity in IntelliPics Studio's Design mode.

As you view the Ladybugs Song activity in Design mode, notice that the content of this IntelliPics Studio activity is the same as it was in IntelliPics, but the presentation has been enhanced—the activity occurs on several pages of a document, and read-aloud text boxes have been added. The ability to create multipage documents and read aloud text boxes are two useful IntelliPics Studio authoring features.

1. Click the Design item (above the page) to view the document in Design mode. Notice the Ladybug’s Song palette at the left of the page.
2. Click the Hide Palettes item (above page) to hide the Ladybugs Song palette, as it is unnecessary for students to use and may be distracting.
3. Click the Next Page item. The Ladybug’s Song activity begins.
4. Click the text box to hear the text read aloud a second time. Each time you click a read aloud text box, the message will be repeated.
5. Click the Next Page item to view the following page (it includes the text: “I flew away and then there were 4.”) Click the door and play the animation again. Click the Play IntelliMation item to play the animation a third time.

Displaying palette items for students to use is another useful feature of IntelliPics Studio.

Design mode enables students to extend their learning by allowing them to hear the text repeat, highlighting as it reads. They can also repeat the animation on the page, encouraging more interaction.
Part 1: Viewing Imported and Enhanced *IntelliPics* Activities

**Viewing Who is in the Shed? in Explore Mode**
You might want to have an activity that includes both Explore and Paint. You will view Who is in the Shed? to see an example of how Paint mode might enhance the original *IntelliPics* version of the activity.

1. Open Who is in the Shed? in Activity Set 2 on the *Fun, Two, Three!* CD, using the steps on page 3. This activity will open in Explore mode.
2. Click the screen to experience the activity as it originally played in *IntelliPics*. Each click provides more information about, and a more complete picture of, a series of farm animals in the shed.

**Viewing Who is in the Shed? in Design and Paint Modes**

1. Click the shed item to display Design mode. (To make this activity more intuitive for use by children, the icon on the Design item has been changed to the image of the shed.)
2. Click an animal or animals from the palette on the left of the page.
3. Move the animal on top of the shed (you may want to leave part of the animal in the doorway). Notice that the animals speak and make a noise when they are clicked on the page.
4. Click the Eraser in the upper right corner. The animal will “disappear” inside the shed. (To make this activity more intuitive for use by children, clicking on the Eraser automatically displays the activity in Paint mode.)
5. Use the cursor, which now looks like an eraser, to erase the picture of the shed until the animal is visible.
6. Click the Design item (with the picture of the shed on it) to play the activity again. (You can use the delete key on the computer to remove the animals from the screen.)
7. Save this activity under a unique name, such as Find the Animal in the Shed.

This activity gives students practice in problem solving. You can create versions of the activity with part or none of the animal showing in the shed door, or with one or several animals inside the shed. Students can play this game with each other.
Part 1: Viewing Imported and Enhanced IntelliPics Activities

Viewing Animated Animals in Explore Mode
One of the most popular IntelliPics activities is Animals. You will examine a variation of this activity titled Animated Animals to see the similarity between IntelliPics and IntelliPics Studio.

1. Open Animated Animals in Activity Set 1 on the Fun, Two, Three! CD, using the steps on page 3. Notice that in Explore mode this screen looks very similar to the original IntelliPics activity.

2. Click any animal to place it on the page. The animal will animate and make a sound. Use the Number, Size, and Color items to vary the number of the animal on the page, to make the animal larger or smaller, or to change its color.

Viewing Animated Animals in Design Mode
Now you will use Design mode to compare the sizes of animals, relative to one another.

Comparing Size
1. Click the Design item at the top left of the page.
2. Click the bear, at the left of the page, three times to place three bears on the page.
3. Click the Make Bigger tool at the bottom of the page to make one of the bears very large.
4. Select a second bear on the page. Use the Make Bigger tool to make this bear medium sized.
5. Arrange the bears on the page to match the picture on the right.
6. Now you will create directions for the students who will use this activity. Select the Text tool.
7. Click and drag the cursor across the screen to create a text box. Type the text: 'Put the bears in order, from the smallest to the largest.'
8. The next step is to make the text box read aloud. Hold down the [Ctrl] key and click the text box.
9. Click to place checks in the boxes in front of Lock and Read Only Text. Click OK.
10. Use the mouse to click the text box. It will read your directions aloud.
11. Save your activity as Animated Animals Modified.

Part 1: Viewing Imported and Enhanced IntelliPics Activities
Part 1: Viewing Imported and Enhanced *IntelliPics* Activities

Using Color and Backgrounds

Now you will add a second page to this activity that provides practice with color. You will also add a background picture to the page.

1. From the Pages menu, select New Page. This adds a new page to your document.
2. Click the Select tool.
3. Click the bird item at the left of the page two times. This will place two birds on the page.
4. Select each bird and use the Make Bigger tool to increase the birds’ size.
5. Now you will create directions for the student to use this activity. Click the Text tool. Click and drag the cursor across the screen to create a text box. Type the text: Make one bird red. Make one bird yellow.
6. The next step is to make the text box read aloud. Hold down the [Ctrl] key and click the text box. The Properties of Text Box dialog box displays.
7. Click to place checks in the boxes in front of Lock and Read-Only Text. Click OK.
8. Now you are ready to choose a background for this page. At the top of the page, click the Show Backgrounds item. A palette of background choices displays at the right of the page.
9. Click the park background. The park appears behind the birds.
10. Now you will add another animal to the background, using the Paint mode.
11. Click the Paint item. The birds “disappear,” but they are not really gone. In Paint mode, you are working with the background layer of the document that is behind the birds.
12. Click the snake and place it on the page. Choose its location carefully, as you will be stamping it (fixing it) onto the background and will not be able to move it once you click the screen.
13. Click the Design item again. Reposition the birds, if desired.
14. Save your work. Using the techniques you have just learned, there are endless possibilities for creating and adapting this animated animals activity for students.
Now that you have seen how IntelliPics activities can be viewed and also enhanced in IntelliPics Studio, the next section of the tutorial will show you how to import an IntelliPics activity into IntelliPics Studio.

On the Fun, Two, Three! CD you will find the original IntelliPics activity titled Snowman Coloring Book. You will import the activity into IntelliPics Studio using two different strategies.

- The first strategy will give you the same access to Explore mode that was available in IntelliPics.
- The second strategy will use the new Explore, Paint, and Design template, which allows you to expand the interaction available to the user.

An additional feature of IntelliPics Studio is that it allows you to save student work into individual portfolios.

**Importing IntelliPics Activities into IntelliPics Studio’s Explore Mode**

1. Close all previously opened IntelliPics Studio files.
2. From the File menu, select Import IntelliPics File.
3. Navigate to and open the Snowman for Tutorial folder. (Windows users: Files of type – All Files.)
   - If you installed this set of activities, the folder is on your desktop.
   - If you did not install the activities, the folder is on the CD, inside the Activities folder, inside the Imported IntelliPics Activities folder.
4. Select the Snowman Coloring Book file. Click Open.
5. The Import IntelliPics Activity dialog box displays. In the Choose a Document Style area, make sure that IntelliPics is selected (this is the default selection). Click Import.
6. The Save As dialog box displays. Name the file Snowman Coloring Explore. Click Save. The activity displays on the page and reads the directions aloud.
7. Click each succeeding screen to play this activity. On many screens you can color the snowman to match the color of the juice the snowman drank. The recorded voice reads the caption again.
Note: to stop the speech at any time press the [Esc] key on the computer keyboard.

7. Notice that when you click a color, you also hear synthesized speech reading a page number. You can turn off this speech feature:
   a. From the Options menu, select Snowman Coloring Explore settings. The Snowman Coloring Explore Settings dialog box displays.
   b. Click the Caption tab.
   c. Deselect Speak Caption. Click OK to close this dialog box.

8. Click to move to a new screen. Now only when you the text will be read in the recorded voice.

As you have seen, importing an existing IntelliPics activity into the Explore mode of IntelliPics Studio enables students to use the activity in a familiar way. However, it does not provide any of the enhanced, interactive features available in IntelliPics Studio.
Part 3: Importing into the Explore, Paint and Design Template

In the next part of this tutorial, you will import the Snowman activity into the IntelliPics Studio Explore, Paint, and Design template. This template includes all the features of Explore mode but also enables you to expand a students’ ability to interact with the activity.

1. From the File menu, select Import IntelliPics File.
2. Navigate to and open the Snowman for Tutorial folder (Windows users: Files of type – All Files).
   - If you installed this set of activities, the folder is on your desktop.
   - If you did not install the activities, the folder is on the CD, inside the Imported IntelliPics Activities folder, which is inside the Activities folder.
3. Select the Snowman Coloring Book file. Click Open.
4. The Import IntelliPics Activity dialog box displays. In the Choose a Document Style area, click the radio button in front of Explore, Paint, and Design to select it. Click Import.
5. The Save As dialog box displays. Name the file Snowman Coloring Fun. Click Save.

Modifying the Snowman Activity for Explore Mode

1. The document will open in Explore mode.
2. There are several palettes on the screen that are not necessary for this activity. The only palettes you need on the screen are the Mode and Colors palettes. You can remove extra palettes to simplify the screen for students.
3. Hold down the [Ctrl] key and click the Explore palette item. The Edit Item dialog box displays.
4. Select the Actions icon at the left.
5. The actions associated with this item are listed in the Item Actions list box at the bottom of this dialog box. You will remove palettes listed here, so these palettes will not show on screen when the activity is in Explore mode.
6. Click Show Palette “Quiz” and click the Remove button.
7. Repeat the step above and remove each palette except for Mode and Colors. You should end up...
with four item actions in this dialog box: Explore, Hide All Palettes, Show Palette “Mode,” and Show Palette “Colors.”

8. Click OK to close the dialog box.

Note: if you accidentally remove a palette you want to keep:

a. From the list of actions on the left select Palettes.

b. From the list of actions on the right, select Show Palette.

c. Click the Add: Show Palette button.

d. Use the pull down menu and select the palette by name.

e. Click OK to close the dialog box.

9. Using the mouse, click the Design item. Then click the Explore item to return to the Explore screen using the revised list of actions. The palettes that you selected and removed should no longer be visible.

10. Click the screen to see the Snowman Coloring Book activity in Explore Mode with unneeded palettes removed.

Congratulations! You have imported a file from IntelliPics into IntelliPics Studio.

In the next section of the tutorial, you will learn how you can enhance an imported activity by adding new functionality that is available to you in IntelliPics Studio.
Part 4: Using the Explore, Paint and Design Template

Modifying the Snowman Activity in Design Mode

In Design mode, you can add new functionality to the Snowman activity you have imported. In this section of the tutorial, you will create a multi-page activity with text boxes that read aloud. Since you can save and print a student's responses in this multipage version of the activity, you have a record of a student's ability to select appropriate colors.

To help you keep track of page numbers and item names, you will make some other slight modifications to this activity.

1. Click the Design item.
2. To view the names of the items in the Picture palette, hold down the [Ctrl] key and click the top snowman. The Edit Item dialog displays. Click OK.
3. The Edit Palette Contents dialog displays. Click the Palette Appearance button.
4. Click the Display tab.
5. Click Picture and Item Name. Click OK to close all dialog boxes. Now you can see that the items in the picture palette at the left were named as pages in the original IntelliPics document.

6. IntelliPics Studio will display screens from IntelliPics documents as pages. To view the page numbers in IntelliPics Studio, from the View menu select Show Status Bar. The status bar below the page shows Page 1 is displayed.

Modifying Page 1

1. Click the first picture item, titled Pg1.
2. Notice that the snowman is placed on the screen. Click the snowman and move it to the center of the screen.
3. Use the Make Bigger item, at the bottom of the page, to enlarge the snowman.
4. Click the Text tool at the left of the page. Click and drag across the screen to create a text box above the snowman.
5. Type the text that appears at the top of the page into the text box you just created. (This text is a caption in Explore mode. It will not stay on the
Part 4: Using the Explore, Paint and Design Template

screen when you add a different item. Therefore the text box you create will allow students to see and reread the text.

6. After you type the text, click the Select tool, which looks like an arrow. You can now move the snowman again, or resize the text box.

7. When you are satisfied with the layout, hold down the [Ctrl] key and click the text box. The Properties of Text Box displays. Select Read-Only Text and Lock. Click OK to close this dialog box.

8. Hold down the [Ctrl] key and click the snowman. Click Lock. Click OK to close this dialog box.

   The text is now locked on the screen and the snowman is fixed to a location.

10. Using the mouse, click the text box. It will read out loud. Click the snowman. You will hear the digitized speech.

Modifying Page 2

1. From Pages menu, select New Page.

2. A new blank page displays. Click Pg2, the second item in the Pictures menu at the left of the page. The picture placed on the page shows colored juice jugs.

3. Repeat steps 2–10 above to resize the picture and create text for this page.

   Note: On this page, the juice jugs are different colors, and it would be preferable if the student could not change the colors. Hold down the [Ctrl] key while you click one of the jugs to display a Properties dialog box. Select Lock and deselect Respond to Mouse Clicks. Close the dialog box.

Modifying Remaining Pages

1. From Pages menu, select New Page.

2. A new blank page displays. Click Pg3, the third item in the Pictures menu at the left of the page. The picture shows a red snowman.

3. Repeat steps 2–10 above to create this next page.

4. Repeat these steps to create each of the other pages, using the picture items that came from the IntelliPics activity.

5. Select Save frequently as you work.
Adding Page Sound

One of the powerful features available in *IntelliPics Studio* is the many ways students can interact with an activity. Students can click a text box to hear the text repeated. They can also click the snowman on each page to hear the digitized speech again. Sounds can also play automatically when students turn to a new page.

1. Use the blue Previous Page arrow to go to Page 1.
2. Hold down the [Ctrl] key and click the page. The Page Properties dialog box displays.
3. Click Page Sounds tab.
4. In the Recorded Sound list box, highlight the sound named pg1. (This is the sound that was automatically imported from the original *IntelliPics* activity.)
5. Click the Play button to verify that this is the sound you want students to hear on Page 1. (Press the [Esc] key to stop playing the sound.)
6. Click OK. This will attach the sound to Page 1, and it will automatically play when the page opens.
7. Use the Next Page arrow to go to Page 2. Repeat steps 2–6 above to add the pg2 sounds to this page.
8. Continue to add the page sounds to each additional page of the activity.
9. Save your work.

Adding Finishing Touches

After you design your activity, there is no need to have extra palettes on the screen that students will not use. (Students only need page arrows and colors.) A Hide Palettes item is located at the top of the page. You will make a small modification to the item so that when the user selects the Hide Palettes item, the activity will go to Page 1 and hide all unnecessary palettes.

1. Hold down the Ctrl key and click the Hide Palettes item. The Edit Item dialog box displays.
2. Click the Actions icon at the left.
3. In the Available Actions, in the left column select Palettes. In the right column, select Show Palette.
4. Click the button Add: Show Palette.
5. Using the pull down menu that lists all the palettes included in this activity, select Colors. The action Show Palette “Colors” will appear in the Actions box at the bottom of the dialog.

6. In the Available Actions list box, in the column on the left, select Pages. In the column on the right, highlight the action Go to Page.

7. Click the button Add: Go to Page.

8. From the pull down menu, select Page 1. Whenever the user clicks the Hide Palettes item, the document returns to Page 1, all unnecessary palettes are hidden, and the Colors palette shows.

9. Click OK to close all dialog boxes.

10. Click the Hide Palettes item. The activity will return to Page 1, and unnecessary palettes will disappear.

11. Save your work.

Practice using the activity with the Next Page and Previous page arrows. Listen to the sounds by clicking the text box and the snowman. Check to make sure that all the snowmen are white before you proceed to the next step, which is saving the final version of your document as a template.

**Saving as a Template**

Once you have finished the activity you can choose to save the document as a template. Each time a student opens a template, it opens as an untitled document that the student can save into his or her own portfolio.

1. From the File menu, select Save As. The Save As dialog box displays.

2. Click the Template tab.

3. To create a new subject area, click the Edit Subject Areas button. Type in the name Imported Files. Click OK.

4. Name the file: Snowman Color Fun.

5. Click OK to close the dialog.

Congratulations! You have imported a file from IntelliPics and modified it using IntelliPics Studio. You have expanded and enhanced the ways students can use this classic activity. In the last section of this tutorial, you will learn to create an overlay for this file if your students will be using it with an IntelliKeys keyboard.
Part 5: Creating the Overlay

You may be working with students who need to use the IntelliKeys keyboard to access the activities you create. If so, in this section of the tutorial, you will learn to create an overlay that students can use in both the Design and Explore modes of the Snowman Coloring activity.

You will need to have Overlay Maker installed on the computer in order to create an overlay for an IntelliKeys keyboard. IntelliPics Studio has been designed to help you create overlays from activities quickly and easily.

You will open the file, create the overlay, and then save the file with a new name. The overlay will automatically be placed inside the IntelliPics Studio Overlays Folder. It will be attached to the file and be available when the file opens. The overlay you will create is used in both Design and Explore modes.

Making the Overlay

1. If it is not already open, open the template Snowman Color Fun.
2. From the File menu, save this document as Snowman Color 2.
3. From the View menu, select Explore. It will be easier to create the overlay from the Explore mode version of the document.
4. From the IntelliKeys menu, select Make Overlay. The Make Overlay dialog box displays.
5. In the Select Palettes menu, only three palettes should be selected. The Colors and Mode palettes should already be checked. Scroll down the list of palettes and click the box in front of the Top Palette item to select it. Click OK.
6. The Save As dialog will display. The name for your overlay is automatically listed as Snowman Color 2 Overlay. Click Save.
7. Overlay Maker will automatically launch, provided it is installed on your computer.
8. An overlay will open, with the items in the three palettes you selected automatically placed on the overlay. The appropriate key content is also already created for each key.
Modifying the Overlay

This overlay will work better for your students if you make a few modifications. You will delete two keys that are not needed, move the position of several keys, and add two new keys.

1. Click the Paint key to select it. Press delete on your keyboard to remove the Paint key.
2. Click and drag the Save key to the place where the Paint key used to be located.
3. Click the Create IntelliMation key. Press delete.
4. Move the Play IntelliMation key to the right.

To enable the user to select items (such as the text boxes and the snowman) on the Design mode screen, you will now add two new keys. One key will have the key content 'tab'. The other key will have the key content 'enter'. You can either create these keys or copy them from another overlay. For this tutorial you will copy the keys from another overlay.

6. From the File menu, select Open.
7. Navigate to the IntelliPics Studio folder (probably located inside the IntelliTools folder on your computer’s hard drive).
8. Once you have located the IntelliPics Studio folder, open it and locate the Overlays folder. Select the overlay A Day at the Beach, and click Open.

9. You should now have two overlays open. Move or resize them, so that you can see both overlays at the same time.
10. On the A Day at the Beach Overlay, select the key that looks like a finger pointing. From the Edit menu, select Copy.
11. Now select the Snowman Overlay. From the Edit menu, select Paste. The key will appear on the Snowman Overlay, including the needed key content. (The key content for this key is already set as 'tab'.)
12. Repeat the steps 10 and 11 above, copying and pasting the key with the Thumbs Up picture. (The key content for this key is already set as 'enter'.)
13. Resize the keys to fit the space in the lower row of the Snowman Overlay.
Part 5: Creating the Overlay

14. The overlay is now complete. From the File menu, select Save.

15. The overlay is now attached to your document, Snowman Color 2. You can now save this document as a Template, so that it can be used over and over without changing the template.

16. From the File Menu, select Save As.
17. Click the Template tab.
18. Name the document Snowman Color 2.

Congratulations
Congratulations! You have learned to import existing IntelliPics documents into IntelliPics Studio, to enhance them, and to create overlays to accompany your enhanced activities.

Be sure to check the IntelliTools Web site, www.intellitools.com, for more ideas and activities related to using IntelliPics Studio.